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Corned beef on rye, cabbage and the wearing of the 
green are all signs of Saint Patrick’s Day. Every year the 
Saint Patrick’s Day Parade marches right in front of my 
building. Although in the past, I could only catch a 
glimpse of it, I plan on being Irish for at least an hour to 
enjoy the festivities.  
 
For those of our members that missed the February 
meeting, Anthony Gologanoff, from Playhouse Square, 
told us about the CEO Program they are offering to eve-
ryone. This program will allow you to purchase upcom-
ing events at a reduced cost. Guess what the best part 
is? It is absolutely free. I will email you information soon 
explaining how you can take advantage of this offer.  
 
The North Coast Chapter will be hosting the next Lake 
Erie LAN meeting on Saturday, March 19 at Eaton Cor-
poration located on Curtis Blvd off of Rt 91 & Rt 2. Conti-
nental breakfast begins at 9:30 am followed by the meet-
ing from 10:00 to noon. It would be nice to show a good 
representation of our members since we are the hosts. 
This meeting provides you the opportunity to meet, net-
work, voice concerns and hear what the other chapters 
are doing. So set your alarms early for that Saturday 
morning and join us. 
 
The Board is working on booking a speaker for the APW 
event. We welcome all ideas. If you would like to help us 
out, please contact any Board member. We are also 
looking for door prizes for this event. In combining our 

event with another Community Service project, there will 
be someone from “Dress for Success” to talk to us. 
Please remember to bring in your donations that day. 
 
Vicki Galecki CPS/CAP has been working with her 
Scholarship Committee and they have sent out the 
scholarship applications to area schools. Did you see 
our announcement on the front page of the News Herald 
this past week? I am hoping that Vicki gets some addi-
tional interests from this publicity. Deadline for applying 
is March 31. Please forward the application to anyone 
you think may be interested. Any questions, please con-
tact Vicki. 
 
ODAM is approaching, so please book your room if you 
haven’t already. This year it will be held at the Bertram 
Inn in Aurora. It will be a weekend of great speakers, 
networking and fun. Registration should open up soon. 
Contact Sue Zacher CPS/CAP, Co-Chair, if you would 
like to help out.  Hope to see you there. 
 
Who do you feel would make a good leader for our 
Chapter? The Nominating Committee needs members to 
step up. There are available positions on the Board for 
2011-2012. How about some new faces? Please con-
sider holding a position, we cannot do this alone. 
 
Our next meeting is March 9. Renee Ferritto CPS/CAP 
will present “Grace Under Fire”. You will receive a recer-
tification point for this presentation. 
 
See you at our March 9 meeting.  
 

H appy Saint Patrick’s D ay!H appy Saint Patrick’s D ay!H appy Saint Patrick’s D ay!H appy Saint Patrick’s D ay!    
 

 
 

President             
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"Grace" Under Fire 
Our own North Coast Chapter Vice President,  

Renee Ferritto, CPS/CAP 
will present a workshop demonstrating how we can  

perform with grace while under fire 
         

Schedule for the Evening  Cost (Includes Buffet Din ner) 
             

5:30 PM  -  Networking  IAAP Member  -  $18.00  

6:00 PM  -  Buffet Dinner  Non Member  -  $18.00  
6:30 PM  -  Speaker    *** MARCH SPECIAL *** 
7:30 PM  -  Business Meeting  Purchase a regular price meeting at  

8:00 PM  -  Adjourn    $18 and bring a guest for only $12 
           

         

  Where: The Kirtlander Party Center (Side Entrance)   
   9270 Chillicothe Road (Route 306)   
   Kirtland, OH (Appx 1.7 Miles South of I-90)   
         

Complete the registration form at the bottom.  Checks and registration must be received 
no later than Friday, March 4 at 8:00 PM.  Cancellations must be made no later than 

Friday, March 4, at 8:00 PM.  Cancellations after the deadline are NON-REFUNDABLE. 
Substitute registrants and guests are welcome.  Please call 440.543.3739 for information. 

         

We look forward to meeting you! 
                  

Make checks payable to:  North Coast Chapter, IAAP 
Forward check & registration form to: Bridget Fenjac, 15800 Messenger Rd, Burton, OH 44021 

□ IAAP member $18 per person □ Non-member $18 per person □ Mar Guest Special  $12  

□ Receipt Required 
           

NAME (please print)               
           
MARCH GUEST OF (if applicable)             
           
WHERE DID YOU HEAR ABOUT US?           
           
COMPANY / ORGANIZATION             
           
ADDRESS (non members)             
           
DAYTIME PHONE (everyone)             
                  

www.iaap-northcoast.org 

Copies permitted 



 

  North Coast Chapter IAAP   

  2010 - 2011 Speakers   

  Date   Topic / Event   Speaker / Location   

  

March 9, 2011   Grace Under Fire 
(an IAAP Workshop) 

  Renee Ferritto, CPS/CAP 

  

        $0 - 1 Pt   

  

April 13, 2011   APW 
Community Service - Suit Yourself 

    

  

  
May 11, 2011   Annual Meeting & Scholarships    

Vicki G.   

  
June 8, 2011   Installation of Officers                                            

Ohio Division Update 
  Sue Straub CPS/CAP                                            

OD President-Elect 2010-2011   

    Susan.Straub@davey.com   $0    

  

Contact:  Renee Ferritto 
Vice President - North Coast Chapter                                                                                 

 reneeferritto@eaton.com                                   
  

                                                  Subject to Change 
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Just Click to Respond . .  

This is to remind you that when 

you see the monthly meeting 

Evite come into your e-mail in-

box, it takes only a moment to 

look at it and give your response 

with a simple click. 

Many of you don’t bother to even 

respond, so please be considerate 

and click YES or NO on the Evite, 

so that the Board will know.  

Membership News 
IAAP-HQ has just announced a special, rare, opportunity for past mem-

bers to rejoin!  Between now and March 31, any former member who 

has dropped from active status within the last two years may rejoin 

and the $15 reinstatement processing fee will be waived.  If you know 

any of our former members who may wish to rejoin, please tell them 

about this opportunity!  There won’t be a better time to come back to 

the best organization for office professionals!  This offer is only for rein-

stating former members; new members joining will still need to pay the 

processing fee as usual.  If you have any questions, contact Member-

ship Chair Cyndy Sleigh CPS/CAP at csleigh@suite224.net . 

MARK YOUR CALENDARS!  
 

Lake Erie LAN Meeting  

Hosted by North Coast Chapter  

Saturday, March 19  

 

Eaton Corporation (CR TCC-Main)  

34899 Curtis Blvd  

Eastlake OH 44095  

 

More details to follow via an evite.  



 

MARCH 2011 

4 Reservation deadline for the March chapter meeting. 

6-9 Spring Conference at the Hyatt Regency in Tampa, Florida. 

9 
“Grace Under Fire” will be presented by Renee Ferritto 
CPS/CAP. 

9 Ash Wednesday 

13 Daylight Saving Time Begins 

17 St. Patrick’s Day 

19 Lake Erie LAN Meeting at Eaton Corporation, Eastlake, Ohio. 

20 First Day of Spring 

31 Deadline for scholarship applications. 

APRIL 2011 

1 All Fool’s Day 

8 Reservation deadline for the April chapter meeting. 

13 
APW Celebration 

Community Service - Dress for Success. 

15 Tax Day 

17 Palm Sunday 

19 Passover 

22 Good Friday and Earth Day 

24 Easter 

27 Administrative Professionals Day 

29 National Arbor Day 

MAY 2011 

6 Reservation deadline for the May chapter meeting. 

8 Mother’s Day 

11 Annual Meeting and Scholarships. 

30 Memorial Day 

5 Cinco de Mayo 

6-7 CPS/CAP Exams 
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  1 2 3 4 5 

6 7 8 9 10 11 12 

13 14 15 16 17 18 19 

20 21 22 23 24 25 26 

27 28 29 30 31   

Christine  
Sebrasky 

Donna Fabiny 

Sun Mon Tues Wed Thurs Fri Sat 

Doniella Ligon 4 years 2007 

Eileen Simpson CPS/CAP 8 years 2003 

Andrea Zacher 14 years 1997 

Pamela Znidar 3 years 2008 
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 ����    

 
 May 2011 
����    

 
 April 2011 
����    

 

March 2011 
You are so LUCKY! 

This month, we’re giving you a speaker sneak-peak  
Visionary Leadership presented by Bill Beausay  

 

 February 2011 
You’ll ����  the  ODAM 2011!   

Be sweet to yourself and reserve your room today! 
Don’t wait! Less than 5 months until ODAM 2011 

 

 COUNT DOWN to ODAM 2011 
 

 Bertram Inn, Aurora, Ohio 

 
 To make reservations online:  

•  •  •  •  Visit www.thebertraminn.com and click on the "Reservations" button at the top of the 
     screen.  
••••  Then select "Groups" below the center box. When asked, type in "IAAP" as the attendee 
    login to see rate and room information for the official room block. 
••••  Reservations may also be made by calling the hotel at 1-877-995-0200 and mention that  
    you are with the IAAP Group. 
••••  The hotel rate is $109 per night plus taxes.  

 For any additional questions, please contact: 
 ODAM 2011 Co-Chairs Janis Hittle, CPS/CAP, at janis.hittle@davey.com or janhittle@gmail.com, or Sue Zacher, 

CPS/CAP, at susan_zacher@beminc.com. 
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N orth Coast Chapter                                     

North Coast Chapter 

Serving Office Professionals throughout Lake, Geauga, and Ashtabula Counties  

February 2011 
 

 ADMINISTRATIVE PROFESSIONAL SCHOLARSHIP ANNOUNCEMEN T 
 
The North Coast Chapter of the International Association of Administrative Professionals® (IAAP)  
annually awards scholarships to qualified applicants of Lake, Geauga, and Ashtabula counties who are  
pursuing careers as office administrative professionals.  Two scholarships, a $1,000 and a $600 scholarship, 
will be awarded in 2011.  These scholarships are based on professional goals, academic achievement, and 
financial need.  To become a scholarship recipient, you must meet the criteria and qualifications specified 
with the North Coast Chapter IAAP® (NCC IAAP) Scholarship application.  Scholarship funds, approved 
by the Scholarship Committee, may be used for tuition, lab fees, and/or books directly related to attending 
school in the Fall Semester 2011.  The scholarship will be paid directly to the approved attending school. 
 
 To apply, completion of a two page application and a written 200 word essay is required.  To help  
determine eligibility for the scholarship, it is important that the answers are complete and that all requested 
information be included.  The process includes a personal interview of select qualified applicants with the 
Scholarship Committee in April.  If selected as a recipient of a scholarship award, attendance is required for 
the Scholarship Award presentation at the NCC/ IAAP May 11, 2011 (evening) Chapter meeting.  SIGNED 
APPLICATION AND ESSAY MUST BE POSTMARKED OR E-MAILE D NO LATER THAN 
THURSDAY, MARCH 31, 2010.  
 
Interviews will be conducted on Saturday, April 16, 2011 at the Mentor Public Library. 
 
 
 

To obtain an application, please contact North Coast Chapter Scholarship Chairperson, Vicki Galecki at 
440-570-6469 or e-mail at vickigalecki@hotmail.com.  For additional information concerning our local 
professional organization, please visit our website at www.iaap-northcoast.org. 

 
 

Please copy and distribute to qualified students as  needed. 
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 North Coast Chapter Page 1 of 4 

Serving Office Professionals throughout Lake, Geauga and Ashtabula Counties 

February 2011 
 

 SCHOLARSHIP APPLICATION INFORMATION  
FOR ADMINISTRATIVE PROFESSIONALS 

 

The North Coast Chapter of the International Association of Administrative Professionals® (IAAP) annually 
awards scholarships to qualified applicants of Lake, Geauga, and Ashtabula counties who are pursuing  
careers as office administrative professionals. These scholarships are based on professional goals, academic 
achievement, and financial need.  To become a scholarship recipient, you must meet the criteria and  
qualifications specified by the North Coast Chapter IAAP® (NCC IAAP) Scholarship application.   
Scholarship funds may be used for tuition, lab fees, and/or books directly related to attending school in the 
Fall Semester 2011 and must be approved by the Scholarship Committee.  The scholarship will be paid  
directly to the approved attending school. 
 

To apply, please fill out the two page application completely and include your essay.  It is important that 
your answers are complete and that all requested information be included to help determine eligibility for the 
scholarship.  SIGNED APPLICATION MUST BE POSTMARKED OR E-MAILED N O LATER 
THAN THURSDAY, MARCH 31, 2011 TO: 
 

Vicki Galecki 
Scholarship Chairperson  
7141 Rippling Brook Lane 
Mentor, OH  44060 
 

If you have questions, please contact North Coast Chapter Scholarship Chairperson, Vicki Galecki at 440-
570-6469 or email vickigalecki@hotmail.com.  For additional information concerning our local professional 
organization, please visit our website at www.iaap-northcoast.org. 
 
  

 

 
  
 Please copy and distribute NCC IAAP application to qualified students as needed . 

                        The Scholarship Committee schedule for the Year 2011 is: 
 
 February 1-8 Scholarship Applications Distributed to Schools 
 March 31 Postmark Deadline for Scholarship Applications and Essays 
 April 16 Selected Applicant Interviews at Mentor Public Library, Francis 
  Cleveland Room (2nd floor), 8215 Mentor Ave, Mentor 
 May 11 Scholarship Recipients Recognized at the NCC IAAP Meeting 
  Kirtlander Party Center, 9270 Chillicothe Rd (Rte 306), Kirtland 
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 North Coast Chapter Page 2 of 4 

Serving Office Professionals throughout Lake, Geauga and Ashtabula Counties 
 

The North Coast Chapter of the 
International Association of Administrative Profess ionals ® 

2011 SCHOLARSHIP APPLICATION 

 
The following criteria MUST be met to qualify for the IAAP scholarship: 
 
� The scholarship candidate must be currently enrolled in or will be enrolled in the Fall Semester 2011 
 in an accredited business/technical school or college and hold a minimum of 12 credit hours 
 
� The scholarship candidate’s studies must be concentrated in Office Administration, with an empha-

sis on administrative business skills 
 
� High School graduate – copy of diploma or GED 
 
� Cumulative grade point average of 3.0 or above – copy of  transcript from high school or college  
  
� Type and double space a maximum 200 word essay  (see page 4 instructions) 
 
� The candidate must complete page 3  of the NCC IAAP Scholarship Application form completely, 

include  your essay, a copy of your diploma or GED, a copy of your high school or college transcript, 
and submit via USPS mail postmarked or e-mail by Thursday, March 31, 2011 

 
� The candidate must make him/herself available for an interview prior to final selection to be con-

ducted on Saturday , April 16, 2011, 10:00 a.m. – 3:00 p.m. , Mentor Library – Francis Cleveland 
Room 

 
� The candidate must attend the Wednesday , May 11, 2011 dinner meeting (5:30 p.m. – 8:30 p.m.) of 
       The North Coast Chapter of the IAAP to receive their scholarship 

 
 
For further details contact: 
Scholarship Chairperson:  Vicki Galecki 440-570-6469 or vickigalecki@hotmail.com 
 
Mail or e-mail the signed completed application, re quired copies, and essay to:   
 

Vicki Galecki 
Scholarship Chairperson  
7141 Rippling Brook Lane 

Mentor  OH  44060 
E-mail:  vickigalecki@hotmail.com   

Awarding Two Scholarships 
$1,000 and $600 
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 North Coast Chapter Page 3 of 4 

Serving Office Professionals throughout Lake, Geauga and Ashtabula Counties 

The North Coast Chapter of the 

International Association of Administrative Profess ionals ® 

SCHOLARSHIP APPLICATION 
 

Name ________________________________________________________________________________ 

Address _____________________________________City, State, Zip______________________________ 

Daytime Phone (      )__________Evening Phone (     )__________Email____________________________ 

Are you a High School Student? _______ Graduation/GED Date ________ 

Name of Last High School Attended ________________________________________________________ 

Have you been awarded other scholarships?  ______   

If yes, name of the scholarship(s):   _________________________________________________________ 

Scholarship award amount(s):  _____________________________________________________________ 

Name of accredited Business/Technical School or College you will be attending in the Fall Semester 2011 

_____________________________________________________________________________________ 

How many credit hours are you planning to take in the Fall Semester 2011?   ______________ 

List any academic awards or volunteer activities  ______________________________________________ 

_____________________________________________________________________________________ 

_____________________________________________________________________________________ 

Signed Application and Essay must be postmarked or e-mailed no later than THURSDAY, MARCH 
31, 2011. 
 
It is my understanding that this scholarship is to be utilized in furthering my career as an administrative professional.  If the criteria 
are not met, I understand that the scholarship will be forfeited and returned to the North Coast Chapter, IAAP®.. 
 
I hereby submit my application for a scholarship to be awarded by the North Coast Chapter of the International Association of  
Administrative Professionals®.  I understand that the scholarship will be paid directly to the school of my choice as approved by the 
NCC IAAP Scholarship Committee. 
 

 ______________________ _________________________________________________________________________________________ 
DATE    APPLICANT SIGNATURE  
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 North Coast Chapter Page 4 of 4 

Serving Office Professionals throughout Lake, Geauga and Ashtabula Counties  

  

The North Coast Chapter of the  

International Association of Administrative Profess ionals ®
 

  

ESSAY  

  

Type and double space a maximum 200 word essay and submit with application  

  

The essay is an important means by which we judge your communication skills. 

  
This essay should identify your goals, the reason for selecting an administrative office  
professional career, and include any facts that should be considered particularly those of 
financial assistance needed. 
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March 6-9, 2011 Hyatt Regency, Tampa, FL 

OHIO DIVISION ANNUAL MEETING (ODAM) 

June 24-26, 2011  Bertram Inn, Aurora, Ohio 

CERTIFICATION SEMINARS 

October 9-12, 2011 Sheraton San Diego Hotel & Marina, San Diego, CA 

FUTURE IAAP EFAM’s  

July 24-27, 2011 Montreal Palais de Congress Convention Center, Montreal, Quebec 

July 22-25, 2012 Gaylord Texan Resort, Grapeville, TX 

SPRING CONFERENCE 

IAAP Goals… 

 

Provide educational resources and  

opportunities to achieve and maintain the highest level 

of professional competence and professional  

development.  Project a professional, strong, and  

authoritative image, which is recognized and valued by 

the business community. 
  

IAAP Mission is… 

 

Enhancing the success of career-minded administrative 

professionals by providing opportunities, for growth 

through education, community building and leadership 

development. 
 

The North Coast Chapter serves office 

and administrative  

professionals in Lake, Geauga, and  

Ashtabula Counties in Northeast Ohio. 

Do you have something you want included in 

the North Coast Breeze?  Please submit it to  

Eileen Simpson, CPS/CAP at  

elsoffice@windstream.net no later than the 

20th of the month.  Thank you. 
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Administrative Professionals Week 2011  

April 24-30  
 

We're excited about the Administrative Professionals Day, April 27, 
2011. This year’s APW theme: This year,  
celebrate all office professionals.  
 
With the difficult economy and a recession that doesn't seem to want 
to end, office professionals everywhere have felt the impact of trying 
times. That's why this year, we're sharing our day with all office  
professionals.  
 
With this shift in focus for 2011, we would like individual members, 
chapters and divisions to see this as an opportunity to promote IAAP 
within the office and the community and foster goodwill between  
admins and other professionals in the office. This will open up  
avenues to promote your local chapter and IAAP. 
 
How can you promote APW? Here are a few suggestions:  
• Place a flyer on every coffee shop, grocery store and office  
      bulletin board you can find. These APW images can be used as 
      flyers or ads for your local paper. 
• Chapters, if you haven’t already planned an event with the  
      international board theme, hold APW events for the entire  
      workforce with the APW theme: This year, celebrate all office  
      professionals. Some topics that would apply to most office  
      professionals could include office communication or a résumé  
      workshop. 
• Watch the website for new APW press releases coming in 

March. 
• Chapters/divisions, post the APW slogan/logo on your websites 

• Send an APW day e-card to co-workers/bosses – We will create 
an APD e-card you can send to your co-workers. It will be  

      available in the March editon of Connections. 
• Invite co-workers to a free APW webinar which will be 
      announced at a later date. 
• Host a simple APW “thank you” breakfast with rolls and coffee. It’s as simple as stopping at the donut shop,  
      picking up a few dozen and inviting the office for their own APD celebration. 
• Next month we'll provide you with an article by IAAP International President Mary Ramsay-Drow that you can 

offer to your local paper for its editorial page. 
 
All supporting materials can be found by logging in to the IAAP Web Community > resources tab > IAAP International 
Library > APW. 
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Cheat Sheet: 10 Tips and Tricks for Microsoft Word 
 

Posted  02/18/2011 at 10:49am | by Seamus Bellamy, 
Paul Lily, and David Murphy  

 
Microsoft Word. The name's practically synonymous 
with "productivity app." If you're reading this article at 
work (shame on you!) there's a pretty decent chance 
you've got a Word doc open right now, and you  
probably think you've got a good handle on Microsoft's 
word processor. We'll bet you don't know as much as 
you think you do.   
 
Don't believe us? Read on for 10 quick tips and tricks for Microsoft Word--
we think at least a few will surprise you. If you're such a Word expert that 
they don't, hit the comments and share some of your favorites tips. 
 

Be Selective with How You Select 
 

You already know that double-clicking selects a single word, and you 
probably figured out that triple-clicking selects an entire paragraph. But if 
you just want to select a single sentence, hold down Ctrl and click on any 
word. To select an entire table, hold down Alt and double-click. 
 

Add a Comment Box 
 

When a friend or family member sends you a document to proofread, 
don’t waste your time writing a lengthy email detailing all the horrendous 
mistakes you found; mark up their Word file instead. Highlight a portion of 
text, click the Review tab in the Ribbon bar, and select New Comment. 
 

Insert Bullets and Number Lists Using Your Keyboard 
 

When inspiration hits, lifting your fingers off the keyboard to use your 
mouse can mess up your mojo, but what do you do if you need to insert a 
bullet or numbered list? It’s simple: type an asterisk and hit the spacebar 
to auto-create a bullet list. You can do the same with numbers and 
dashes. 
 

Use the Built-In Thesaurus 
 

You don’t need to hop online to use a thesaurus, the folks in Redmond 
had the good sense to bundle one in Word. To use it, highlight an entry 
and press Shift+F7. Pretty simple, right? Or maybe we should say it’s 
trouble-free, straightforward, effortless, uncomplicated, or painless. 
 

Backup/Transfer Your Settings 
 

Nearly every customization you make to Word gets saved in the  
Normal.dot template, a hidden file that you should keep backed up. You’ll 
find it by navigating to 
C:\Users\[username]\AppData\Roaming\Microsoft\Templates. Be sure to 
enable viewing of hidden files, folders, and drives. 
 

Extend Word’s Trial Period 
 

 

 
Microsoft allows you to test drive Office 2010 free for 30 days; after that, 
you have to pony up for a license and activate. Or you can ‘rearm’ Office 
for another 30-day trial, up to 5 times for a total of 180 days. To rearm, 
open an elevated command prompt and go to C:\Program Files\Common 
Files\Microsoft Shared\OfficeSoftwareProtectionPlatform and run  
OSPPREARM.exe. If you installed the 32-bit edition of Office on a 64-bit 
OS, replace Program Files with Program Files (x86). 
 

Insert Screenshots into Word 
 

One of our favorite new features in Word 2010 is the ability to glue screen 
grabs right into the document we’re working on. Just use the Print Screen 
key as normal to grab an image, and then go to Insert > Illustrations > 
Screenshot. 
 

Hop Back and Forth with Bookmarks 
 

 
 
To add a bookmark in Word, position your cursor and go to Insert > Links 
> Bookmark. Give your bookmark a name and click Add. To jump back to 
that point, just go back to the Bookmark menu, highlight your entry, and 
click Go To. 
 

Select Text Vertically 
 

Did you mess up your numbered list? Maybe some funky symbols got 
placed at the beginning of each sentence when you copied over an email. 
Whatever your reason for wanting to select text vertically, you can do so 
by holding down the Alt key and using your mouse cursor. 
 

Password Protect Work Documents 
 

 
 

One of these days, you’re going to punch your obnoxious roommate 
square in the face for digging around your personal documents. Or better 
yet, just lock your docs. To password protect a Word document, click on 
File > Info > Protect Document > Encrypt with Password. 
 
 
 

Taken from the March 2011 issue of Maximum PC magazine. 
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Cheat Sheet: 12 Tips and Tricks for Microsoft Excel 
 

Posted 02/09/2011 at 3:46pm | by Seamus Bellamy, 
Paul Lily, and David Murphy  

 
Excel isn't the sexiest application in the world--it has an unfortunate association 
with the type of Milton-esque office drones we all wish we weren't. All the same, it's 
a program that most people will end up having to use at some point in their life, and 
it's one with a lot of arcane secrets. Read on for 10 quick Microsoft Excel tips and 
tricks that will get you accounting like a pro in no time flat. 
 

Time to Pivot 
 

 
 
Pivot Tables are one of Excel’s most useful—and misunderstood—features. Here’s 
a quick lesson: Click within a chunk of data, click Insert, and select “Pivot Table.” 
Excel should automatically pick the entire range of said data (provided you don’t 
have any blank columns interrupting your dataset), and convert this into an  
editable, table-as-you-go kind of setup.  You can use the various “fields” on Excel’s 
new sidebar to basically create new tables of information (and calculations) on-the-
fly. 
 

Let’s Lookup! 
 

Another widely used, but often confusing feature of Excel is Vlookup—the function 
by which one looks at data A, finds data A and data B in another spreadsheet, and 
slaps data B somewhere into the original spreadsheet. It’s tricky to explain, but 
easy to use: You’re basically using the contents of a single cell as an anchor for 
referencing information from one location to another. Master the command, and 
you’ll find a new use for it every day! 
 

Conditional Formatting is your Friend 
 

If formulas aren’t your thing, here’s an easy way to duplicate data between two 
columns. Highlight the columns and select Excel’s Conditional Formatting feature 
on the Home tab. Then, select the “Highlight Cells Rules” listing and pick whatever 
option fits your style. Duplicate values, for example, would highlight all repeated 

instances with a given color. 
 

Insta-Jump to a Cell 
 

Did you ever stop and wonder if you can actually modify the cell listing that appears 
to the left of the Excel’s formula bar?  You know, the one that automatically 
changes to tell you exactly row and cell you’re on at any given moment?  Guess 
what: You can.  Click on it, and then type in a given row name and column  
number—you’ll jump right to that cell as if you just hopped through a magical  

portal.  Really, it’s that fun. 
 

Get Set for Macros 
 

Trying to discuss Excel macros in a tiny paragraph is like trying to stuff an elephant 
into a car.  However, the first step toward being able to use Macros is an easy one: 
Open up Excel’s options (Jewel button > Excel Options) and select “Customize 
Ribbon.”  Click on the unchecked “Developer” box that’s on the right-side of the 

options window, and you’ll gain access to the “hidden” section of Excel that’s a 
quick shortcut to the almighty macro. 
 

Why Not Numbers? 
 

From time to time, Excel will foolishly store numbers like a “0” as text instead of a 
numeral, which can be a real pain if you’re trying to do anything with said  
information. So how do you fix 23,414 rows of the same error? Insert a new column 
and type a “1” into an empty cell. Select it, copy it to your clipboard, then select the 
range of numbers you’re looking to fix. Click on the drop-down menu under the 
Paste icon, click “Paste Special,” and select the options “Values” and “Multiply.” 
 

Why Not Empties? 
 

Dovetailing off the previous tip, Excel also has a nasty habit whereby information 
you’ve modified such that a cell should be empty… isn’t.  The cell has no values in 
it per se, but it still doesn’t register as empty for uses of the Count command or 
things like that. The easy way to fix this is to simply sort your affected columns in A-
to-Z order, then manually select the range of “blank” cells starting at the bottom of 
the listing all the way down to Excel’s final row. Now, hit “Delete.” 
 

Delete Blank Rows 
 

If you have a bunch of data that’s separated out by blank rows of cells for whatever 
reason, it’s easy to just nuke these out of your dataset forever without having to do 
any kind of crazy sorting. Select a column, hit F5, click on Special, then select the 
“Blanks” option. With said blank rows now targeted, click over to Excel’s Home tab, 
select “Delete,” and choose the option for eliminating said rows. 
 

Show Thy Formulas 
 

This one’s quick, but super-effective: If you have a spreadsheet full of formulas and 
you want to see exactly how you’ve built all of your constructions, you can do this 
by hitting CTRL+~, which will instantly transform your spreadsheet from values to 
the formulas that constructed them. 
 

Double-Click to Freedom! 
 

Double-clicking various parts of the Excel interface can automate a number of 
functions, including: double-clicking on the Jewel to close Excel, selecting multiple 
columns and double-clicking on the separators to auto-adjust the widths of all, 
double-clicking on the tabs of Excel’s ribbon menu to minimize the whole thing, 
double-clicking the lower-right corner of a cell to Fill Down its contents based on the 
contents of the column to its left… the list goes on!  When in doubt, double-click. 
 

Adding Multiple Lines of Text 
 

It’s frustrating to try to add multiple lines of text to a given cell. How the hell do you 
do it? The answer is so easy, it’s almost shocking. When you want to insert a line 
break in a cell to split your text up in a more readable fashion, just hold down Alt 
and hit Enter. Technically, you’re also turning on “Wrap Text” for the affected cell as 
well. 

 

Email… Anything! 
 

Check out the Excel plugin RDBMail if you want to super-charge your ability to 
quickly email portions of a worksheet to an Outlook recipient. It adds a new tab to 
your Ribbon that you can use as a single-click utility for emailing your entire  
worksheet to a person or the pertinent parts that you’ve selected. You can also 
toggle between sending the worksheet as-is—formulas included—or sending off 
only the values of what you’ve been working on. 

 
 
 
 

Taken from the March 2011 issue of Maximum PC magazine. 
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